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Version Date Modifications (Contents, Pages) 

Ver1.0 05.12.29 First Edition 

Ver1.1 06.03.13 

1、 Modify the camera setting screen. 

2、 Increase the control screen for the number of cameras 

when the system starts. 

3、 Store the setting scheme of the camera in a file. 

4、 The DO mode of the camera in the original system is 

retained, and the user can select the DO mode or RS232 

mode when the system is started. 

Amend chapter 1.1 and add chapter 2.3, 3.4 and 

chapter 9 about the control of multiple cameras 

Ver1.2 06.05.11 

1. The camera position automatically switches to the 

default value when the program starts, and the default 

value can be set by the user. (Modify sections 4.3.1 and 

9.3) 

2. It is forbidden to drag the unit graphics randomly in the 

non-conference editing state. (Modify section 4.14) 

3. After the device detection is completed, a message box 

pops up in the middle of the screen to report the 

detection result. (Modify section 4.15) 

Ver1.3 07.01.22 
About the camera link function 

Connect the video switcher to the system 

Ver1.4 19.11.07 

Remove the existing camera function and replace the 

camera with an ONVIF camera 

Added language switching 

Replace the sample image with a new version 

Ver1.5 19.12.02 Add TS-D1000 description 

Ver1.6 20.04.07 
Updated legend for some screens, added 5.10, 125% font 

drag problem 
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１ Introduction 

１-１System Connection Diagram 

The system indicates the control of the camera, as shown below： 
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１-２Operation 

Operating System：Windows 10 64 bit 

２ System Installation 

２-１RS-232 communication 

The TS series uses DB-9 connectors for RS-232 communication. If your 

computer does not have a dedicated DB-9 connector, please use a USB to DB-

9 serial converter. Windows 10 supports most of these devices without the 

need for separate drivers. If the main conference device is a TS-D1000, please 

make sure that the computer where the software is installed is on the same 

network segment as the TS-D1000 

 

２-２Software Installation 

To install “ConferenceSystem” on your computer, follow these instructions: 

(1) Insert the installation disk into the CD-ROM drive, find the "Setup.exe" file 

in the installation directory under the CD, and double-click to start the 

installation. 

(2) When the installation starts, a prompt box as shown in the figure below 

will pop up, click the "Yes" button to start the installation. 
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(3) After confirming that you want to start the installation, the program enters 

the Windows installation wizard, as shown below 

 

Click the "Next" button to continue or click "Cancel" to cancel the installation. 

 

(4) Set the installation path of the software in the dialog box as shown in the 

figure below,  

click the "Next" button to continue or click the "Back" button to return to 

the previous. Click the "Cancel" button to cancel the installation. 
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(5) If the installation directory you selected already exists, a dialog box as 

shown in the figure below will pop up, click the "Yes" button to continue 

the installation, or click the "No" button to return to the previous dialog 

box to select a different location, or Cancel the installation. 

 

The next screen will prompt you to place a link to the program in the Start 

Menu folder as shown in the figure below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the "Next" button to continue or click the "Back" button to return to 

the previous step. Click the "Cancel" button to cancel the installation. 
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(6) The next dialog box prompts you to select whether to put a program 

shortcut on your desktop. Click “Next” to continue or “Back” to return to 

the previous step. Click “Cancel” to cancel the installation 

 

 

If the settings are correct, click the "Install" button to start the installation, 

as shown in the figure below. During the installation process, you can click 

the "Cancel" button in the dialog box to cancel the installation. 
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(7) After the installation process is completed, a dialog box (as shown in the 

figure below) will pop up. Click the "Finish" button to complete the 

installation. The dialog box has a "Start Conference System" check box. 

By Selecting it means that the program will start immediately after the 

installation is completed. 
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３Launching the Software 

３-１ Launch software 

Start the software by selecting "Conference System" from "Programs" in the 

"Start" menu. The software will be installed, the following message will pop-

up, prompting the user to log in the user name and password. 

 

 

 

Screen display and resolution must be correctly set, 

 

If the computer resolution is 1920*1080, the display and layout support up to 

125% zoom. If the computer resolution is 1366*768, the screen display and 

layout only support 100% zoom. 
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If the font selection in Windows is 125%, you need to right-click the program 

icon on the desktop. 

 

Select attributes 

 

Select Windows Icon in the compatibility option, and then click the [Change 

High DPI] setting, and tick [Replace High DPI Zoom Behavior, Zoom Execution:] 

in the popup screen to avoid screen artifacts when dragging a cell in the 

program editing screen. 

 



TOA CONFERENCE SYSTEM – SOFTWARE INSTRUCTIONS 

 

p. 14 
 

３-２Project name and password 

Project Name: TOA 

Password: admin 

Enter in the Login box. If you are using a TS-D1000 in your system, you will 

need to enter the IP address here. The monitoring computer and the TS-D1000 

must be on the same network. 
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３-３Camera Setting 

 

After the user logs in correctly, the following screen will appear: 

 

 

In the screen above, the user can select a previously saved meeting file or 

create a new one. By default, the control of the conference file and camera 

follows the last setting. Click OK to move to the Main Interface. 
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４Conference Connection 

 

When the user logs on, the Meeting Master Interface pops up, as shown in the 

following image. If the communication with the main device is normal and the 

current meeting is selected, then the program automatically performs a device 

connection test to find out which meeting units are online in the current 

meeting. 
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４-１Menu 

４-１-１System Menu 

 

①  Open 

Clicking on the "Open" option in the System menu pops up the Open File 

dialog box. Select a meeting file from the list of .icm files. The meeting 

interface will automatically be adjusted the last saved audio level, voting 

function, timer, and camera functions, which can be modified and saved in 

the file at the end of the meeting as the initial setup for the next meeting. 

If there is connection between the software and the conference master unit 

when the file is opened, the device connection test will start automatically 

to determine how the meeting unit devices are connected and to distinguish 

between the displays in the screen. 

 

②  Enter Meeting Editor 

If a meeting is not in progress, you may click the Enter Meeting Editor 

option in the system menu. The program will close the currently open 

meeting screen and enter the Meeting Editor screen. From this screen, you 

can modify the locations, names, and IDs of units shown in the meeting 

unit display. Details are explained in a later section 

 

③  Select 

In the Meeting Master Interface page, click on Options in the System menu. 

The "Meeting Options" dialog box pops up, and the user can set some 

parameters which will take effect immediately, regardless of whether the 

meeting is in progress or not. Details of these settings will be explained in 

a later section 

 

④  Exit 

To exit the Meeting System Interface, click on the "Exit" option in the 

System menu. A pop-up message box will ask whether you really want to 

exit the conference system or not. If you exactly want to exit, the meeting 

will stop immediately and then exit from the system even if the meeting is 

still on going. 

 



TOA CONFERENCE SYSTEM – SOFTWARE INSTRUCTIONS 

 

p. 18 
 

４-１-２Command menu 

 

①  Start speaking 

Select a conference unit graphic from the graphic display area. If the 

conference unit is online and not in the speaking state, then click on "Start 

Speaking" to turn on the unit’s microphone.  

         

This command is invalid in any of the following situations: 

 Before the meeting 

 No meeting unit graphic selected 

 Voting in progress 

 Device connection test 

 The selected conference unit is not online 

 

②  Stop speaking  

Select a conference unit graphic from the graphic display area. If the 

conference unit is online and already in the speaking state, then click on 

"Stop Speaking" to turn off the unit’s microphone.  

         

This command is invalid in any of the following situations: 

 Select a conference unit graphic from the graphic display area. If the 

conference unit is online and already in the speaking state, then click 

on "Stop Speaking" to turn off the unit’s microphone.  

         

③  Stop All Speaking 

To turn off all microphones during a conference, click the 

"Stop All Speaking" command from the "Command" menu to turn off all 

conference unit microphones.  

         

This command is invalid in any of the following situations: 

 Before the meeting 

 When no one is speaking 

 Voting in progress 

 Device connection test 

 

HINT: All of the above commands are accessible by right-clicking on the conference unit graphic 
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４-１-３Settings menu 

 

①  Speaking parameter change 

In the "Speaking Parameter Change" dialog box, the user can choose the 

priority of microphones (LIFO, FIFO, 1 fixed +LIFO), the number of open 

microphones allowed by the system and whether the Auto Mic-Off function 

is disabled. We will discuss these options in a later chapter. 

 

When TS-D1000 is selected (shown below), the number of open 

microphones defaults to 8. 
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②  Camera settings 

The system is initially set to ONVIF communication control mode. Click the 

"Camera Resource Setting" item in the "settings" menu, and the system 

pops up the "Camera Resource Setting" dialog box, as shown in the 

following figure. 

 

In this dialog box, the user can set the control mode of the camera to 

automatic or uncontrolled and save the configuration to a file. For further 

information on this setting, please refer to the "Camera Resource Settings" 

section. 
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③  System parameter setting 

Click the "System Parameter Setting" item in the "Settings" menu. The 

system pops up the "System Parameter Setting" dialog box as shown in the 

following figure. In this dialog box, the user can set the communication 

interface between the software and the TS 800 / TS900 main device and 

can set the “save path” of the conference file and log file. For more 

information on this setting, please refer to the "System Parameter Setting" 

section. 

 

 

When TS-D1000 is selected, the screen is displayed as follows- 
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４-１-４Log menu 

 

① Speech record 

Click the "speaking record" item in the "log" menu. The meeting log window 

pops up, as shown in the figure below. The window will display the last 

meeting record. To view the past records, enter a date in the “date input” 

box at the upper left of the window. That record will be transferred to the 

list box below. Click the "Print" button in the log window to print out the 

logs in the list. 

 

② Voting record 

Click the "voting record" item in the "log" menu. The system pops up the 

meeting log window as shown in the figure below. The window initially 

displays the voting records of the day. To view past records 

enter the date in the “date input” box at the upper left of the window and 

the system will automatically call up the records of that day and display 

them in the list box below. Click the "Print" button in the log window to 

print out the logs in the list. 
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③ Camera Usage 

Click the option with the mouse, the system will pop up the window as 

shown in the figure below: 

The status of cameras currently used is displayed. 

 

４-１-５“Display” menu 

 

The options in this menu are mainly used to display the position of the meeting 

personnel in the meeting, the voting results or the speaking time in full screen 

to allow the contents to be displayed on a larger screen. 

 

① Voting 

From the "Display" menu, select "Vote" and click the mouse or press the 

shortcut key Ctrl + V to enable a full-screen window as shown below. 

 

Click the exit button in the upper right corner to exit the window. 
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② Meeting layout 

Select "Conference Layout" from the "Display" menu, click the mouse or 

press the shortcut key Ctrl + G to enable a full-screen window as shown 

below. 

 

This window displays the name, location and status information of each 

conference unit in the current conference. Click the exit button in the upper 

right corner to exit the window 

 

③ Speak time 

Select "Speak Time" from the "Display" menu and click the mouse or press 

the shortcut key Ctrl + T to enable a full-screen window as shown in the 

figure below. This window displays the speaking time information in the 

lower right corner. Click exit button in the upper right corner to exit the 

window. 
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４-１-６“Help” menu 

 

①  About   

Clicking the "About" item in the "Help" menu, displays the software version 

and information about the software, as shown in the figure below. 

                 

 

４-２Toolbar 

４-２-１  Equipment Installation Test 

 

When the user clicks the command on the toolbar, the system starts the 

device connection test process. If the communication connection is normal, 

the system will pop up the progress window of device detection as shown 

in the figure below. 

It disappears automatically upon completion. 

 

４-２-２  Start Vote 

 

This command has the same function as the "Start" button in 4.7 voting 

control. 

４-２-３  Stop Voting 

 

This command has the same function as the "Stop" button in 4.7 voting 

control 
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４-３Conference Control 

 

The conference control screen is displayed on the upper left of the 

conference Main Interface, as shown in the following figure. The user can 

control the start and end of the meeting. Red text indicates whether the 

current meeting is in progress or stopped 

 

 

４-３-１  Start of meeting 

 

Click the "conference start" button in the above screen. If the 

communication connection is normal, the device connection test process 

starts. After the connection test process is completed, the device 

connection status will be shown in the in the graphics display area. These 

status colors can be modified at any time according to their needs. For 

further information on this topic, please refer to the content of "Conference 

Options". If the start is successful, the "Conference Start" button dims, and 

the "Conference End" button is highlighted. The device ID number in the 

upper left corner of the conference unit graphic is hidden. Hover the mouse 

over the graphic and the ID number will show. 

When a camera is used in the system, if the conference starts successfully, 

the camera will automatically go to the default location set in the Camera 

Resource Settings dialog box. 

 

 

４-３-２  Terminate Meeting 

 

The user clicks the "Conference Termination" button in the above screen, 

the command will end the conference and display the conference unit. The 
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ID number on the graph retains the online or offline status of each unit, the 

"Conference Start" button is highlighted, and the "Conference End" is 

dimmed. 

 

４-４Current Number of people online 

This result is refreshed after the device connection test process. The left box 

shows the number of chairman units, the center box shows the number of 

delegate units, and the third box shows the total number of units connected. 

 

４-５Microphone Volume Adjustment 

① As shown in the figure below, you can use the mouse to drag the faders 

to adjust the microphone volume. 

 

The range of volume setting values is 1-32. The user can also double-click 

the input box with the mouse, and directly enter the required value. If a 

non-numeric character is input or the value exceeds the setting range, the 

system prompts an input error. 

Note: The main volume control is still set by turning the "MIC UNIT INPUT " volume knob on the 

control panel of the main unit. The volume adjustment in the above software is only a fine 

adjustment within a certain range. 
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② If you are using a TS-D1000, the drop-down box range becomes -20dB to 

+ 8dB 

 

４-６Camera Control 

If the camera function is on when the program starts and the conference 

settings use the camera function, then the right side of the conference Main 

Interface will have a screen showing the camera status as shown in the figure 

below. " OFF " indicates that the software is not controlling the camera 

direction, while " ON " indicates that the camera has been aimed at a 

conference unit. 

 

４-７Voting Control 

Voting control operation is shown below. The "start"  and "stop"  button  

perform the same function as in the toolbar. 

 

 

 

 

 



TOA CONFERENCE SYSTEM – SOFTWARE INSTRUCTIONS 

 

p. 29 
 

① Start Voting 

For TS900 / TS910 / TS920, if voting function is enabled, then the left side 

of the conference Main Interface will display the voting screen as shown 

above. In addition, two command buttons, voting start and stop, have been 

added in the toolbar. 

During the meeting, the user clicks the "Start" button on the screen, and 

the system displays the input box as shown below. 

If communication fails, the input box will not pop up. This input box requires 

the user to enter the subject name of this vote in order to record it in the 

log. When the voting is successfully started, the "Start" button is grayed 

out, and the "Stop" button is highlighted. 

 

② Stop Voting 

Press the “Stop” button to end the voting.  

 

Note: T S-D1000 and 800 series have no voting function 

 

４-８Remaining Talk Time 

If the user has enabled the “remaining time for speaking” function, the screen 

shown in the figure below appears on the right of the Main Interface. When 

you click the "Start" button in the screen and someone is currently speaking, 

the time in the input box will count down until it is zero, and if the “Stop 

Speaking” check box is selected, and the counter reaches zero, the unit’s 

microphone will be turned off. If the check box is not selected, the unit’s 

microphone remains on, but the “overtime” amount is now shown in red. You 

may pause the timer or modify the remaining time. The maximum time 

allowed is 59 minutes and 59 seconds. Minimum time setting is 0. 
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４-９Device Connection Status 

On the right side of the conference Main Interface, there is a display of the 

status of the software and hardware connection, as shown in the figure below. 

The left side of the display shows connected conference units, and the right 

side shows connected cameras (only shown if the Camera Function is selected 

in the login form and Camera Function is selected in the Conference Use 

Function Display. Green lights indicate normal connections. Red lights indicate 

disconnected devices or faulty communication. 

 

４-１０Conference unit status color 

At the bottom right of the conference Main Interface, the representative colors 

of each status of the conference unit are displayed. These colors may be 

changed, but two status states cannot use the same color. 

 

Device Status for TS-D1000 
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４-１１Status Area 

At the bottom of the conference Main Interface is the status area. as shown in 

the figure below. The first column in the status area displays operation status 

information during the conference. The next four columns represent four 

speaking channels. If there is a speech on the channel, the corresponding 

channel status color will change to green. The next two columns let you know 

if the Number and CAPs keys are on. The last columns show the date, time, 

and day of the week, respectively. 

 

There is no color change on the status bar when the selected device is TS-

D1000 

 

４-１２Title Bar 

The display format of the title bar is: 

Conference System - Project Name- [ Name of Meeting] 

 

４-１３Conference unit Graphics 

The conference unit icons are displayed in the graphic display area of the 

conference Main Interface. These represent the units available in the 

conference. 

They correspond to the actual hardware device through a unique ID address. 

When the status of the hardware device changes, the status of the 

corresponding conference unit icon changes accordingly 

 

４-１４Graphic Display Area 

While in a conference, icons in the Graphic Display Area are not moveable. You 

must be in Edit Mode to rearrange icons 
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４-１５Equipment Installation Test 

The software automatically performs a device connection test after opening 

the conference file to obtain the status of each conference unit. This test may 

take some time if the conference system is large. When the system performs 

device connection testing, the completion progress form of the test is displayed, 

as shown in the following figure. If you think the current graphic display is 

consistent with the actual hardware status, you can click the "Cancel" button 

on the progress form to terminate the device connection test process. 

 

After the device connection test is completed, a device check report will pop 

up to inform the user of the device check result. As shown below: 

 

The report shows the number of online units, offline units and total number, 

as well as the unit ID and unit name of units with a low battery. Click the 

"Recheck" button to perform the device connection test again. Click the 

"Confirm" button to close the report. 
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５Meeting Editing Interface 

Click the "Enter Meeting Edit" button in the System menu of the Main Interface 

or the icon in the toolbar to enter the Meeting Editing Interface. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

５-１Title Bar 

The display format of the title bar is: 

Meeting Editor - Project Name- [Name of Meeting] 

 

５-２Menu 

５-２-１“File” menu 

①  New   

To open a new conference file, select the "New" item from the "File" menu. 

If there is no unsaved data in the Edit Mode, the system will pop up the 

"New Meeting" dialog box as shown in the figure below. 

Conf Name 

Use Function 

Menu 

List 

Setting Conf Unit Graphic Graphic editing area 
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If you have unsaved changes to a conference file, the system prompts the 

user to save the changes to the current meeting. After the changes have 

been saved, enter the conference name in the conference name input box, 

and the number of participants in the conference. After confirmation, the 

graphics editing area will display a neatly arranged group of icons based on 

the Unit Count and display the meeting name information in the title bar. 

The ID attribute of the icons is based on the order of entry. Fill in the names 

of participants that correspond with an icon’s ID. 

 

②  Open 

To open an existing file, select " Open " from the "File" menu. If the 

currently edited meeting has been modified but not yet saved, the system 

will prompt you  to save the changes, and then a dialog box to open the 

meeting file will pop up, as shown below As shown, the initial path for 

opening the dialog box is the 

 

Save path. The conference file type is ".icm ". After the file is opened, the 

graphic information saved after the last edit of the conference is displayed 

in the graphic editing area. 

 

③  Save 

To save a conference, select " Save " from the "File" menu. This will save a 

meeting to its existing file. If the meeting is a newly created meeting, the 

system pops up a save dialog box as shown in the figure below, asking the 

user to enter the save path and file name. 
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The default “Save” path is specified in the System Settings. The file name 

defaults to the conference name. By default, the saved name is the 

conference name. You cannot save a file without a name 

 

④ Save As 

To save a file as under a different name or in a different location select 

"Save ... " item from the "File" menu. Enter new name and/or location and 

select “Save”. Any alterations to the file before closing the file will be stored 

with the new name and/or location. 

 

⑤  Option 

Options are the same as the Meeting Options box in the Main Interface 

Options are not available during editing 

 

⑥  Exit 

Exits the current system 
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５-２-２“Edit” Menu 

 

①  Cut 

While in edit mode, selects a conference unit to delete and moves it to the 

clipboard 

 

②  Copy 

While in edit mode, select a conference unit to copy to the clipboard 

 

③  Paste 

Click on the graphic area where you want to copy the conference unit, 

then select Paste to copy from the clipboard 

 

④  Delete 

Select a conference unit icon, and then click the "Delete" command in the 

edit menu. 

 

５-３Toolbar 

Most of the commands in the toolbar can be found in the menu. Only the 

following commands cannot be found in the menu: 

 

①  Ordinary 

Under normal circumstances, if you select it, it means the mouse is normal 

and you cannot add conference graphics. 

 

②  Graphics 

Select it, the mouse changes to a cross shape to add graphics to the 

graphics editing area, 

 

③  Font 

A conference unit graphic must be selected in order to access the Dialog 

box. Specify the required font type, size and color, then click "OK". The font 

of the currently selected conference unit graphic is now changed. 

To change the font of all conference unit graphics, select the command "set 

all" from the drop-down list to the right of the item in the toolbar. A font 
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setting dialog box will appear. 

 

５-４Conference Name 

The conference name can be changed as needed during editing. Up to 50 

characters may be used for a Conference Name. When saving, this name will 

be used as the default file name. 

 

５-５Use Function 

The following function setting information is saved in the Conference (.icm) 

file . When the conference file is enabled, the functions of the Main Interface 

are enabled- 

 

① Voting 

Select whether Voting is to be included in the system functions 

 

② Remaining Speak Time 

Enter the time Speak time and select remaining speech time option if 

desired 

 

③ Camera 

Select whether a camera system is included in the system functions. 

 

５-６List of Personnel 

A list of attendees and the ID number of their conference unit. A remarks area 

is provided for notes. The user can edit ID, name and remarks (title, company 

name, etc. of any unit graphic. 

 

５-７Status Area 

Time and date information are displayed in the status area. 
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５-８Conference Unit Graphic 

The graphic structure of the conference unit icon is shown in the following 

figure. It shows the unit address ID number and assigned text (name, title, 

etc.) 

The icon can be dragged to any position in the graphics area. 

 

５-９Graphics Area 

The graphics of the conference unit are displayed in this area. The user can 

conveniently set the conference seating layout. The Graphics Area size is fixed 

and cannot be changed. 

 

５-１０The problem that the drag coordinates do not coincide with the 

actual coordinates in the meeting editing. 

 

When the font selection in Windows is 125% , you need to right-click the 

Conference System program icon on the desktop and select Properties. 

User Name 

Address ID 
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Select Compatibility your Windows, then click [changing the height D the PI] 

is provided in the pop-up screen for the [High DPI zoom behavior, zoom 

execution] tick configure as shown above, otherwise a dotted line will appear 

when dragging the cell on the editing screen 
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６Meeting Options Dialog 

As shown in the figure below, the meeting options mainly include the following 

 

 

 

 

 

６-１Status Color Setting 

The graphics of the conference unit are mainly divided into the following states. 

They are distinguished by different colors when the conference is in progress. 

Online status: the communication between the conference unit and the main 

device is normal. 

Speaking    : It means that the conference unit has started to speak, and it 

is in the graphics. 

Chairman's priority speech: If someone presses the chairman's priority speech   

button on the device, the graph will automatically display in this 

state color. 

Low battery alarm: When a low battery alarm occurs in the conference unit 

device, the graphic of the conference unit in the corresponding 

conference screen is automatically displayed in this state color. 

Offline state: when the communication between the conference unit and the 

Network 

setting 

Conference unit 

status color 

setting 

Voting setting 

Hide the offline meeting 

unit 

Auto aligns 

the grid  

Restore default settings 

Voting record color 

settings 

Background color 

setting 
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main device is disconnected, the conference unit graphic display 

is in this state. 

Speaking request: If someone presses the request to speak button on the 

device, the graph will automatically display in this state color 

 

Select the state to be set from the drop-down list of status options, and then 

click the " ... " button to the right of the drop-down list. The system displays 

a color setting dialog box. After the setting is completed, the color of the 

corresponding option in the drop-down list changes to the set color. The TS-

D1000 does not provide priority to the chairman to speak or battery low 

battery alarm. 

 

６-２Voting Setting 

As shown in the figure, the setting of voting in the options dialog box is to set 

the meaning of three kinds of voting representation, which can be the name 

and number of the meeting personnel. By default, vote 1 means "agree", vote 

2 means "abstain", and vote 3 means "no". 

Click the color button on the right of the input box, the system displays a color 

dialog box, allowing the user to set the background color of the vote in the 

voting log. 

 

６-３Background Color 

The background color of the graphic display area may be changed using this 

setting. 

 

６-４Grid Setting 

Sets the grid size, alignment and grid line color. 
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６-５Display offline device while meeting is in progress 

 

① When this check box is selected, the graphics of those offline conference 

units are displayed in the graphics area when the conference is in progress. 

 

② If this check box is not selected, the graphics of those offline conference 

units will be hidden when the conference is in progress. 

 

Note: The default setting is selected. 

When the meeting is stopped, all configured graphics will be displayed. 

 

６-６Restore Default Setting 

Returns the settings in the dialog to their initial state (the settings after the 

latest software installation), Click "OK" to make the settings take effect. 

 

６-７Voting Records 

① When this check box is selected, the system will record everyone's voting 

content in the voting log 

 

② Without selecting this check box, the system will not record everyone's 

voting content in the voting log, and will not display everyone's voting 

content in the log display window. 

 

Note: The default setting is not selected. 
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７Dialog box for changing speech parameters 

If the user wants to change the speaking parameters, they can click the 

"speaking parameter change" command from the "Settings" menu. The setting 

dialog box shown below is displayed.  

 

 

 

The number of open microphones can be set in the TS-D1000 setting screen. 

 

Note: The content of this parameter setting can also be set on the control panel of the main 

device, but in the case of normal communication between the software and the main device, 

the software setting takes precedence. 

 

 

 

 

 

 

 

 

Speaker Number 

Mic Auto Off 
Speak Mode 



TOA CONFERENCE SYSTEM – SOFTWARE INSTRUCTIONS 

 

p. 44 
 

７-１Microphone (Speech) Priority 

There are three kinds of speaking methods that can be set in the system: 

First In First Out (FIFO) 

When the number of speakers reaches the set limit, requests for speaking will 

not be accepted until the first speaker drops out. 

 

Last In First Out (LIFO) 

① When the number of speakers reaches the set limit, and receives a request 

to speak, first end the first speech, and then accept the send request. 

② For example: Set the number of speakers to 2. Receive the first request 

to speak, (accepted); receive the second request to speak, (accepted); 

Receive the third speech request, first stop the first speech, and then 

receive the request to start speaking. 

 

1 fixed, 2 after use FIFO 

① When the number of speakers reaches the set limit, and then receive the 

request to speak, first end the second speech and then accept request to 

speak. 

② For example: Set the number of speakers to 2. Receive the first request 

to speak, (accepted) receive the second request to speak (accepted) 

Receive the third speech request, first stop the second speech, and then 

receive the request to start speaking. 

 

７-２Number of Speaker 

This parameter sets the maximum number of people who can speak at the 

same time in the conference. The system provides three options. 

 

７-３Microphone Auto Off 

This function is used to turn off a microphone that may have been left open 

by mistake. This may affect the person who speaks later, so if the function is 

turned on, the microphone automatically turns off conference unit microphone 

after detecting that the surrounding volume is below a certain value for more 

than 30 seconds. 'S microphone is turned off, which stops speaking. As shown 
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in the figure, select " ON " to turn on the function, and select "OFF" to turn off 

the function. 

 

Note: The content of this parameter setting can also be set on the control panel of the main 

device, but in the case of normal communication between the software and the main device, 

the software setting takes precedence 

 

 

８Camera Resource Setting Dialog 

Click the "Camera Resource Setting" command, the system pops up the setting  

dialog box as shown in the figure below: 

 

８-１ONVIF Camera Setting 

There are many manufacturers of cameras that support the ONVIF protocol, 

but not all functions are supported by all manufacturers. We will use Hikvision 

and Dahua as examples. Dahua cameras have fewer ONVIF support modules 

and only support the zoom function. Hikvision cameras support all the 

functions available in the Conference System software. 

 



TOA CONFERENCE SYSTEM – SOFTWARE INSTRUCTIONS 

 

p. 46 
 

８-１-１HIKVISION Camera Configuration 

 

① Before use, please make sure that the camera network the computer 

where the software is installed are on the same network segment. 

② Using the default factory settings of the IP address 192.168.1.64, enter 

the address of the camera into the login screen. When prompted to set up 

a user name and password, do so. 

③ Once online, the basic configuration can be modified. 
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④ The [Enable Illegal Login Lock] check box in the security service in security 

management is not checked, as shown in the figure below. 

 

 

⑤ The rotation speed of the camera to the pre-set value position, you can 

adjust the speed, as shown below. 
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８-１-２HIKVISION Camera Configure ONVI Protocol Account 

 

① HIKVISION Camera browser page, click [Configuration] at the top, click 

[Advanced Settings] in [Network] on the left, and select [Integrated 

Protocol], as shown below. 

 

② 【Enable ONVIF】Check box and add users who are allowed to use ONVIF 

protocol in the user list below 

 

③ Select [Administrator] for the user type, as shown below 
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８-２Add Camera 

To add a camera to the list of cameras, simply select The Vertex Position 

Camera in the tree on the left side of the screen, right-click, select the Add 

option in the pop-up menu, automatically add a camera configuration, or the 

user can select the "Add from File" option, select the camera profile to add to 

the list. 

 

８-３Delete Camera 

If the user wants to remove a camera from the list, just select the option to 

delete in the tree, click the right mouse button, and select the "Delete" option 

in the pop-up menu. 

 

８-４Setting Changes 

Address number: The valid address number of the camera is from 1 to 999, 

and the user sets it according to the address of the live camera. 

Test communication: Input the IP address of ONVIF camera, allow the use of 

ONVIF protocol username and password, and finally click on "Test 

Connection" to test for proper connection to the ONVIF camera, as shown 

below 
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◼ Pointing to the unit 

The user can select the unit to which the camera may be aimed. Without 

the specified unit, the camera cannot be turned to it. 

◼ Preset 

Adjust the camera to the corresponding unit position, then select a pre-set 

location number in the screen. Enter the cell ID and click the "Record" 

button. The position will be saved in the camera's memory. When the 

meeting is in progress, the conference unit will automatically send the 

camera "record confirmation" command and the position of the camera will 

be adjusted to cover the unit. 

Select a unit in the default position drop-down list, the unit will become the 

default position of the camera, and it will be automatically aligned to the 

unit when the camera is idle 

◼ Control Method 

The user can choose the tracking mode of the camera or give up tracking 

as needed. Select automatic "follow first speaker". When there are several 

speakers in the set of units pointed to by this camera at the same time, the 

camera will always follow the first speaker until the end of the speech. If 

you choose to automatically "follow the last speaker", then when there are 

several speakers in the set of units pointed to by this camera, the camera 

will follow the last speaker. Select "Uncontrolled", then the camera is not 

controlled by this software. 

 

８-５Save Setting 

Changed settings must be saved, otherwise the settings are not uploaded. 

Users can save the settings in the following ways: 

 

① Save to list 

Select the "Save (S) " button at the bottom of the dialog box. If the list is 

currently read from a file, the changed settings will be saved to the file. If 

it is a new file, the system will prompt you to enter a name. 

 

② Save to Camera Configuration File (.ccf). 

If the user wants to save individual settings, then click the "Save As ... " 

button to save the file as a single camera configuration file. 
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８-６Search Camera 

 

Click [Search Camera], the search camera interface appears. Enter the range, 

then click [Scan] 

 

If a camera has been used in the configuration, it is not possible to import 

another to the same address 
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９System Parameter Setting Dialog 

As shown in the figure below, there are two main types of system settings: 

TS820 or TS920 settings, and TS-D1000 settings. 

 

TS800, TS900 series                       TS-D1000 
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９-１Communication 

In the system parameter setting dialog box, click the "Communication" to 

display the communication settings. For TS800/TS900 systems, the 

communication protocol is RS-232. The system serial communication port is 

shown in the drop-down list. This port number must be the same as the 

communication port used on the computer. 

The setting will be recorded to a file as the default setting at the next software 

startup until the user enters this dialog box again to modify the port number. 

The TS-D1000 uses network (TCP/IP) communication. 

 

９-２Binder 

In the system parameter setting dialog box, click the "binder" page with the 

mouse to display the settings related to the file saving path, as shown in the 

following figure. The parameters set here are mainly the following two routes: 

① The way to save conference documents 

When the software starts, it automatically searches for the conference file 

from this path and loads the last used conference file. In the Conference 

Editing state, this path is used as the default path for saving conference 

files. 

② Log file save route 

The logs in the system (such as speech records and voting records) are 

automatically recorded under this path. When the log window is opened, 

the program automatically searches for the log file of that day under this 

path, and then reads and displays it in the list box of the log window. 
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１０Meeting Log Dialog 

The log in this system mainly has the following two categories: speaking record 

and voting record. 

 

１０-１Speech Record 

Select "Speaking Record" from the "Log" menu, and the system will pop up 

the log window as shown in the figure below. Initially, the contents of the 

current day’s log are automatically displayed. The records are listed in the list 

box in chronological order. The content of each record is divided into the 

following four columns: 

a) Time: record the time of occurrence. 

b) Name: the name of the meeting or the name of the person 

c) Content: start and stop of speaking or start and stop of meeting 

d) Action time: speaking time or meeting time 

Click any one of these four column headings, and the records will be sorted 

according to the field information. 

 

１０-２Voting Record 

Select "Voting Record" from the "Log" menu, and the system will pop up the 

log window as shown in the figure below. Initial setting is automatically 

Display the contents of the day's log. The records are listed in the list box in 

chronological order. The content of each record is mainly divided into the 
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following five columns: 

a) Time: record the time of occurrence. 

b) Name: conference name 

c) Vote: Voting name 

d) Content: start, stop and content of voting 

e) Result: voting result 

Click any one of these five column headings, and the records will be sorted 

according to the information in this field. 

 

１１Language setting 

① click on the language setting in the left navigation button, to enter the 

language setting screen 

 

② Input language name, Click the "Select File" button to import language file, 

shown in FIG 3 FIG. Note: The uploaded file can only be in csv format, and 

the language name and uploaded file name cannot be the same as the 

existing duplicate name. Finally, click the "Add" button. After the upload is 

successful, the previous language option will be added in the language 

selection box of the login screen 
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１２How to use the software 

After reading the contents of the previous chapters, I believe that you should 

have a certain understanding of the software. The content to be introduced next 

is to teach you some methods of using this software. 

１２-１First Startup 

① Start sequence 

Under normal circumstances, first power on the conference main unit 

TS800 / TS900 and other hardware devices in the system and connect to 

the computer before starting the software. TS-D1000 guarantees that the 

machine and the conference main unit are on the same network segment 

 

② Communication port inspection 

        When the software is started for the first time after installation, all the 

settings in the software are set by default. For example, the communication 

port between the software and the conference main unit TS800 / TS900 is 

serial port 1 by default. If the port where the hardware device and the 

computer are actually connected does not match the default setting, after 

the software is started, the label of the conference main unit TS900 / TS800 

or the camera is displayed in red in the device connection status display 

area, indicating a communication connection failure. You need to change 

this parameter in the system parameter setting dialog box until the setting 

matches the actual connection. After the communication connection with 

the conference main device is normal, the software automatically starts the 

device connection test process. 

 

③ TS-D1000 communication check 

        If the IP address of TS-D1000, username, and password do not match the 

default settings. After the software starts, the device connection status 

display area, the label of the conference main unit TS-D1000 or camera will 

display in red, indicating that the communication connection is faulty. In 

this case, you need to change these parameters in the system parameter 

setting dialog box until the settings are connected matches. 
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１２-２Automatically obtain the ID from the conference unit 

① Detection Range 

During the device connection test, the system will detect each of a valid ID 

number (TS800, TS820 valid ID from. 1 to 64, TS900 valid ID from. 1 to 

96, T S910, TS920 effective the ID from. 1 to 192, the TS-D1000 effective 

the ID from. 1 to 246), and automatically detects the device on the 

graphical display.\ 

 

② Create A Graphic 

If the graphic of the detected device ID is not configured in the screen, after 

the detection process is completed, the system automatically creates and 

displays the graphic corresponding to the ID. So that no matter how many 

conference unit graphics are configured in your conference file, as long as 

a complete (not cancelled) device connection test is started and completed, 

all valid conference unit devices in the conference site will be displayed on 

the software screen. The name of the newly created graphic is empty, and 

you need to enter the conference editing screen to set it. 

 

１２-３Adjust Conference Layout 

After starting the software for the first time to obtain the on-site configuration 

of the graphic layout using the above method, in order to make the location of 

the unit graphics in the conference screen correspond to the location of the 

actual unit equipment, you can use the following methods to adjust: 

① Enter the conference progress state:  

Click the "Conference Start" button in the Main Interface of the conference.  

② Set speech parameters:  

In the speech parameter change dialog box, set the speaking method to 

mode B, the number of speakers is 1, click "OK" button to complete the 

setting.  

③ Start speaking:  

select an online unit graphic from the screen and click the "start speaking" 

command in the "command" menu. 

④ Adjust the position:  

After the unit graphic in the previous step becomes the speaking state, 
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check which of the unit devices in the field is speaking (the microphone of 

the unit device that is speaking has a red light on), and adjust the 

corresponding graphic in the screen. according to its position. When 

adjusting the position of the graphic, you can use the mouse to drag, or 

you can use the shortcut key Ctrl + arrow key (← ↑ ↓) to fine-tune. 

⑤ Repeat steps (3) and (4) until all adjustments are completed. 

 

 

 

 

 

 

 


